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RZ/N2H Group 
Encoder I/F BiSS-C sample program 

Summary 
This document describes the RZ/N2H Encoder I/F BiSS sample program package. 

For BiSS Interface communication protocol specifications and encoder specifications, contact manufacturer 
of each encoder to obtain it. 

 

Functionality Checked Device 
RZ/N2H Evaluation Board (RTK9RZN2Hxxxxxxxxx) 
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1. Package Contents 

This package contains the following contents. 

The BiSS-C encoder interface of the RZ/N2H supports up to 13 axes, but the sample program uses only 1 

axis of them. If you use with 2 axes or more simultaneously, modify the sample program to support required 
axes. 

 

1.1 Software 
• Source code 

No. Name Version 
1 RZ/N2H BiSS-C sample program (CR52 ver. *) 3.0 
2 RZ/N2H BiSS-C sample program (CA55 ver. *) 3.0 

 
Note: This sample program has a CR52 version that runs on the CPU core Cortex-R52 and a CA55 version 

that runs on the CPU core Cortex-A55. CR52 ver. and CA55 ver. are descriptions of the respective 
version. 

 

1.2 Document 
No. Document name Version File name 

1 RZ/N2H Group Encoder I/F BiSS-C 
sample program Release Note 

3.00 (j) r11an0973jj0300-rzn2h.pdf 
(e) r11an0973ej0300-rzn2h.pdf (this document) 

2 RZ/N2H Group BiSS-C sample 
program Application Note 

3.00 (j) r11an0969jj0300-rzn2h-biss.pdf 
(e) r11an0969ej0300-rzn2h-biss.pdf 

 
 



RZ/N2H Group  Encoder I/F BiSS-C sample program 

R11AN0973EJ0300  Rev.3.00  Page 3 of 15 
Nov 7.25  

2. File Structure 

The file structure and contents of this package are detailed below. 
Top 
├─ r11an0973jj0300-rzn2h.pdf  
├─ r11an0973ej0300-rzn2h.pdf  
└─ workspace 
   ├─ Software 
   │  ├─ iccarm 
   │  │  ├─ RZ_N2H_biss.zip  : RZ/N2H BiSS sample program set 
   │  │  │      CR52 ver. (IAR) 
   │  │  └─ RZ_N2H_CA55_biss.zip : RZ/N2H BiSS sample program set 
   │  │          CA55 ver. (IAR) 
   │  └─ gcc 
   │     ├─ RZ_N2H_biss.zip  : RZ/N2H BiSS sample program set 
   │     │      CR52 ver. (e2 studio) 
   │     └─ RZ_N2H_CA55_biss.zip : RZ/N2H BiSS sample program set 
   │             CA55 ver. (e2 studio) 
   └─ Documents 
      ├─ r11an0969jj0300-rzn2h-biss.pdf 
      └─ r11an0969ej0300-rzn2h-biss.pdf 

 

The file structure of the RZ_N2H_CR52_biss.zip and RZ_N2H_CA55_biss.zip are shown below. 
Top folder 
├─ configuration.xml    : FSP Configuration data 
├─ ( Build Tool Dependency Environment File ) 
└─ src  
   ├─ hal_entry.c    : BiSS-C sample program 
   ├─ biss_main.c    : BiSS-C sample program 
   ├─ siochar.c     : SCI_UART sample program 
   ├─ siorw.c     : SCI_UART sample program 
   ├─ sio_char.h     : SCI_UART sample program 
   └─ drv  
      └─ biss 
         ├─ iodefine_biss.h   : BiSS register definition file 
         ├─ r_biss_rzt2.c   : BiSS driver file 
         ├─ r_biss_rzt2_config.h  : BiSS driver file 
         ├─ r_biss_rzt2_dat.h    : BiSS driver file 
         ├─ r_biss_rzt2_if.h   : BiSS driver file 
         ├─ r_biss_rzt2_private.h  : BiSS driver file 
         └─ bissc 
            ├─ r_bissc_rzt2.c  : BiSS-C driver file 
            ├─ r_bissc_rzt2_config.h : BiSS-C driver file 
            ├─ r_bissc_rzt2_if.h  : BiSS-C driver file 
            └─ r_bissc_rzt2_private.h : BiSS-C driver file 
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3. About BiSS Sample Program  

This section contains information necessary to use the complete set of BiSS sample program. 
 

3.1 Software Information 
3.1.1 Base OS 

This sample program is OS-independent. 

 
3.1.2 Memory Size 

Memory size used by this sample program and BiSS, BiSS-C driver is shown in the following table. This 
table does not include the memory size used by Flexible Software Package or C language libraries of the 
compiler. 

 
(1) CR52 ver. 

Items Memory Size 
EWARM 
[kBytes] 

e2 studio 
[kBytes] 

BiSS, BiSS-C driver Code 3.7 3.4 
Data (with initial value) 0.0 0.0 
Data (without initial value) 0.9 0.9 
Constant Data 0.3 0.3 

Sample program Code 3.0 3.4 
Data (with initial value) 0.0 0.0 
Data (without initial value) 0.6 0.6 
Constant Data 1.5 2.0 

 
 
(2) CA55 ver. 

Items Memory Size 
EWARM 
[kBytes] 

e2 studio 
[kBytes] 

BiSS, BiSS-C driver Code 5.8 4.9 
Data (with initial value) 0.0 0.0 
Data (without initial value) 1.1 1.1 
Constant Data 0.4 0.5 

Sample program Code 4.9 6.1 
Data (with initial value) 0.0 0.0 
Data (without initial value) 0.7 0.7 
Constant Data 1.7 1.7 
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3.2 Hardware Information 
3.2.1 Device 

RZ/N2H 
 

3.2.2 Target Board 
(1) Board Name 

RZ/N2H Evaluation Board (RTK9RZN2Hxxxxxxxxx) 

 
(2) Setting of the Target Board 

The target board configuration is as follows. Do not push SW4 while you are using channel BiSS14.  

DSW2-4: ON, DSW2-6: OFF 

DSW5-1: OFF, DSW5-2: OFF, DSW5-7: OFF, DSW5-8: OFF 

DSW7-1: OFF, DSW7-2: ON 

DSW12_5: ON, DSW12_6: OFF 

DSW13-3: OFF, DSW13-4: ON, DSW13-7: ON, DSW13-8: OFF 

DSW20-5: OFF 

DSW21-4: OFF, DSW21-5: ON, DSW21-6: OFF 

DSW3-1: ON, DSW3-2: OFF, DSW3-3: ON, DSW3-6: OFF (Set to xSPI1 boot mode) 

JP8: Short between 2-3pin (Set VDD1833_2 to 3.3V) 

JP9: Short between 2-3pin (Set VDD1833_3 to 3.3V) 

JP23: Short between 1-2 pins, Open between 3-4 pins, and between 5-6 pins (Set VDD1833_6 to 3.3V) 

 
(3) Used pin for Target Board 

The correspondence between the pin used as the encoder I/F and the pin header of the target board is as 
follows. Channels BiSS8, BiSS12 and BiSS15 are not available.  

Channel Port Name Pin Header Input/Output Voltage 
Domain 

Description 

BiSS0 ENCIFDI0 (SL0) CN44 #9 Input VDD33 Sensor / Control data 
ENCIFCK0 (MA0) CN44 #3 Output VDD33 Clock / Control data 

BiSS1 ENCIFDI1 (SL1) CN44 #8 Input VDD33 Sensor / Control data 
ENCIFCK1 (MA1) CN44 #2 Output VDD1833_5 Clock / Control data 

BiSS2 ENCIFDI2 (SL2) CN43 #23 Input VDD33 Sensor / Control data 
ENCIFCK2 (MA2) CN43 #25 Output VDD33 Clock / Control data 

BiSS3 ENCIFDI3 (SL3) CN43 #24 Input VDD1833_6 Sensor / Control data 
ENCIFCK3 (MA3) CN43 #16 Output VDD1833_6 Clock / Control data 

BiSS4 ENCIFDI4 (SL4) CN44 #27 Input VDD33 Sensor / Control data 
ENCIFCK4 (MA4) CN44 #21 Output VDD33 Clock / Control data 

BiSS5 ENCIFDI5 (SL5) CN43 #14 Input VDD1833_6 Sensor / Control data 
ENCIFCK5 (MA5) CN43 #8 Output VDD1833_6 Clock / Control data 

BiSS6 ENCIFDI6 (SL6) CN42 #18 Input VDD1833_3 Sensor / Control data 
ENCIFCK6 (MA6) CN42 #12 Output VDD1833_3 Clock / Control data 

BiSS7 ENCIFDI7 (SL7) CN42 #36 Input VDD1833_3 Sensor / Control data 
ENCIFCK7 (MA7) CN42 #22 Output VDD1833_3 Clock / Control data 

BiSS9 ENCIFDI9 (SL9) CN51 #18 Input VDD1833_2 Sensor / Control data 
ENCIFCK9 (MA9) CN51 #12 Output VDD1833_2 Clock / Control data 
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Channel Port Name Pin Header Input/Output Voltage 
Domain 

Description 

BiSS10 ENCIFDI10 (SL10) CN51 #27 Input VDD1833_2 Sensor / Control data 
ENCIFCK10 (MA10) CN51 #21 Output VDD1833_2 Clock / Control data 

BiSS11 ENCIFDI1 (SL11) CN51 #26 Input VDD1833_2 Sensor / Control data 
ENCIFCK11 (MA11) CN51 #20 Output VDD1833_2 Clock / Control data 

BiSS13 ENCIFDI13 (SL13) CN43 #32 Input VDD1833_6 Sensor / Control data 
ENCIFCK13 (MA13) CN43 #26 Output VDD1833_6 Clock / Control data 

BiSS14 ENCIFDI14 (SL14) CN42 #35 Input VDD33 Sensor / Control data 
ENCIFCK14 (MA14) CN42 #27 Output VDD33 Clock / Control data 
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3.3 Procedures on Development Environments: CR52 ver. 
3.3.1 Preparation before Executing the Sample Program 
This sample program communicates with a PC. The USB connection terminal on the target board is CN27. 
Select higher-numbered port from COM ports that appear at connecting the board with the host PC. 

The terminal software of the host PC is set as shown in the following table. 

Function Setting 
Communication method Asynchronous serial transmission/reception 
Sending / receiving order LSB first 
Transfer rate 19200 bps 
Character length 8 bits 
Stop bit length 1 bit 
Parity function None 
Hardware flow control None 

 
 

3.3.2 EWARM: IAR Systems 
(1) Build Environment 

IAR Embedded Workbench for Arm (EWARM) 

  Version 9.60.3 + patch (EWARM_Patch_for_RZT2H_N2H_rev1.0) 

RENESAS FSP Smart Configurator (FSP SC) 2025-04.1 

RENESAS Flexible Software Package (FSP) for RZ/N2 v3.0.0 

 
(2) Execution Environment ICE 

IAR I-jet 

 
(3) Build Procedure for Sample Programs 

The build procedure for the sample program is as follows. 

1 Extract RZ_N2H_CR52_biss.zip and copy the extracted source files to the desired location. 
2 Activate EWARM. 
3 Select [File] menu -> [Open Workspace].  
4 Open the extracted source file RZ_N2H_biss.eww.  
5 Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. * 

 
Note: The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the 

EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New] 
button, specify a table string in each field, and press [OK]. 

 
Field String 

Menu text FSP Smart Configurator 
Command $RASC_EXE_PATH$ 
Argument --compiler IAR configuration.xml 
Initial directory $PROJ_DIR$ 

 
String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe. 
If the path written as RASC_EXE_PATH in the buildinfo.ipcf file does not match with your rasc.exe 
installation path, please edit the buildinfo.ipcf to fit with your installation path.  
You can also start the FSP Smart Configurator directly from the command prompt by specifying the 
folder where it is installed. 
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6 In the FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzn, 
rzn_cfg, rzn_gen, script and .setting folders will be generated. 
 

 
 

7 When project generation is complete, close the Smart Configurator. 
8 Select [Rebuild ALL] from the [Project] menu of EWARM.   

The file Debug¥Exe¥RZ_N2H_biss.out is generated. 
 
(4) Sample Program Execution Procedure 

After executing the "build procedure", connect the target board and debugger correctly, and perform the 
following operations. 

1 Select [Project] menu -> [Download and Debug]. 
2 Select [Debug] menu -> [Execute]. 

 
(5) Execution Result of the Sample Program 

Run the sample program and enter commands in the terminal software window. For commands, see 
4.11.7 console commands in the RZ/N2H Group BiSS-C Sample Program Application Note.  
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3.3.3 e2 studio: RENESAS 
(1) Build Environment 

RENESAS e2 studio 2025-04.1 

  Toolchain version: GNU Arm Embedded 13.3.1.arm-13-24 

RENESAS Flexible Software Package (FSP) for RZ/N2 v3.0.0 

 
(2) Execution Environment ICE 

SEGGER J-LinkTM v8.30 

 
(3) Build Procedure of the Sample Program 

The procedure for building the sample program is as follows. 

1 Extract RZ_N2H_CR52_biss.zip and copy the expanded source file to any location. 
2 After launching e2 studio and moving to the workspace, click the [File] menu -> [Import] and select 

Existing project to workspace and click [Next].  
3 On the project import screen, select the folder where the sample program was expanded as the root 

directory. 
4 Select a project, check Copy Project to Workspace, and click [Finish].  
5 Double-click the configuration.xml in the Project Explorer pane of e2 studio to open it.  
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6 Click Generate Project Content in the FSP Configuration pane of e2 studio.  
The rzn, rzn_cfg, rzn_gen, script and .settings folders are generated. 
 

 
 

7 Select [Project] menu -> [Build All] 
The Debug¥RZ_N2H_biss.elf file is generated. 

 
(4) Execution Procedure of the Sample Program 

After executing the "build procedure", connect the target board and debugger correctly, and perform the 
following operations. 

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging].  
2 Click [Debug] to start downloading to internal RAM. 
3 Click [Run] menu -> [Resume] to run the sample program 

 
(5) Execution Result of the Sample Program 

Run the sample program and enter commands in the terminal software window. For commands, see 
4.11.7 console commands in the RZ/N2H Group BiSS-C Sample Program Application Note.  

 
 



RZ/N2H Group  Encoder I/F BiSS-C sample program 

R11AN0973EJ0300  Rev.3.00  Page 11 of 15 
Nov 7.25  

3.4 Procedures on Development Environments: CA55 ver. 
3.4.1 Preparation before Executing the Sample Program 
This sample program communicates with a PC. The USB connection terminal on the target board is CN27. 
Select lower-numbered port from COM ports that appear at connecting the board with the host PC. 

The terminal software of the host PC is set as shown in the following table. 

Function Setting 
Communication method Asynchronous serial transmission/reception 
Sending / receiving order LSB first 
Transfer rate 19200 bps 
Character length 8 bits 
Stop bit length 1 bit 
Parity function None 
Hardware flow control None 

 
 

3.4.2 EWARM: IAR Systems 
(1) Build Environment 

IAR Embedded Workbench for Arm (EWARM) 

  Version 9.60.3 + patch (EWARM_Patch_for_RZT2H_N2H_rev1.0) 

RENESAS FSP Smart Configurator (FSP SC) 2025-04.1 

RENESAS Flexible Software Package (FSP) for RZ/N2 v3.0.0 

 
(2) Execution Environment ICE 

IAR I-jet 

 
(3) Build Procedure for Sample Programs 

The build procedure for the sample program is as follows. 

1 Extract RZ_N2H_CA55_biss.zip and copy the extracted source files to the desired location. 
2 Activate EWARM. 
3 Select [File] menu -> [Open Workspace].  
4 Open the extracted source file RZ_N2H_CA55_0_biss.eww.  
5 Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. * 

 
Note: The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the 

EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New] 
button, specify a table string in each field, and press [OK]. 

 
Field String 

Menu text FSP Smart Configurator 
Command $RASC_EXE_PATH$ 
Argument --compiler IAR configuration.xml 
Initial directory $PROJ_DIR$ 

 
String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe. 
If the path written as RASC_EXE_PATH in the buildinfo.ipcf file does not match with your rasc.exe 
installation path, please edit the buildinfo.ipcf to fit with your installation path. 
You can also start the FSP Smart Configurator directly from the command prompt by specifying the 
folder where it is installed. 
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6 In the FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzn, 
rzn_cfg, rzn_gen, script and .setting folders will be generated. 
 

 
 

7 When project generation is complete, close the Smart Configurator. 
8 Select [Rebuild ALL] from the [Project] menu of EWARM. 

The file Debug¥Exe¥ RZ_N2H_CA55_0_biss.out is generated. 
 
(4) Sample Program Execution Procedure 

After executing the "build procedure", connect the target board and debugger correctly, and perform the 
following operations. 

1 Select [Project] menu -> [Download and Debug]. 
2 Select [Debug] menu -> [Execute]. 
 

(5) Execution Result of the Sample Program 

Run the sample program and enter commands in the terminal software window. For commands, see 
4.11.7 console commands in the RZ/N2H Group BiSS-C Sample Program Application Note.  
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3.4.3 e2 studio: RENESAS 
(1) Build Environment 

RENESAS e2 studio 2025-04.1 

  Toolchain version: GCC Arm A-Profile (AArch64 bare-metal) 10.3.1.20210621 

RENESAS Flexible Software Package (FSP) for RZ/N2 v3.0.0 

 
(2) Execution Environment ICE 

SEGGER J-LinkTM v8.30 

 
(3) Build Procedure of the Sample Program 

The procedure for building the sample program is as follows. 

1 Extract RZ_N2H_CA55_biss.zip and copy the expanded source file to any location. 
2 After launching e2 studio and moving to the workspace, click the [File] menu -> [Import] and select 

Existing project to workspace and click [Next].  
3 On the project import screen, select the folder where the sample program was expanded as the root 

directory. 
4 Select a project, check Copy Project to Workspace, and click [Finish].  
5 Double-click the configuration.xml in the Project Explorer pane of e2 studio to open it.  
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6 Click Generate Project Content in the FSP Configuration pane of e2 studio.  
The rzn, rzn_cfg, rzn_gen, script and .settings folders are generated. 
 

 
 
7 Select [Project] menu -> [Build All] 

Files Debug¥RZ_N2H_CA55_0_biss.elf is generated. 
 
(4) Execution Procedure of the Sample Program 

After executing the "build procedure", connect the target board and debugger correctly, and perform the 
following operations. 

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging].  
2 Click [Debug] to start downloading to internal RAM. 
3 Click [Run] menu -> [Resume] to run the sample program. 

 
(5) Execution Result of the Sample Program 

Run the sample program and enter commands in the terminal software window. For commands, see 
4.11.7 console commands in the RZ/N2H Group BiSS-C Sample Program Application Note.  
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Revision History 

Rev. Date 
Description 

Page Summary 
2.00 Dec 23.24  First Edition issued. 
3.00 Nov 7.25 2, 3 

 
4 

7 to 14 

Update revisions of the application note and the release note. 
Update sample program version to 3.0. (Support FSP v3.0.0.) 
Update memory size information. 
Update build environment for FSP v3.0.0. Figures are replaced. 

    
 

 

 



 

 

General Precautions in the Handling of Microprocessing Unit and Microcontroller 
Unit Products 
The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 
2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 
3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 
4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 
5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 
6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 
7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 
8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 
 
 
 
・BiSS is a registered trademark of iC-Haus GmbH. 
・IAR Embedded Workbench is a registered trademark of IAR Systems. 
・J-Link is a trademark of SEGGER Microcontroller GmbH. 
・Arm and Cortex are registered trademarks of Arm Limited (or its subsidiaries) in the EU and/or elsewhere. 

All rights reserved. 
・Additionally all product names and service names in this document are a trademark or a registered 

trademark which belongs to the respective owners. 
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or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this 
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples. 

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics 
or others. 

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export, 
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required. 

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any 
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering. 

6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for 
each Renesas Electronics product depends on the product’s quality grade, as indicated below. 
 "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home 

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc. 
 "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key 

financial terminal systems; safety control equipment; etc. 
Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas 
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to 
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space 
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas 
Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas 
Electronics product that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document. 

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics 
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but 
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS 
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING 
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, 
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND 
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT 
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH 
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. 

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for 
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by 
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. 
Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products 
outside of such specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific 
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability 
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics 
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily 
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as 
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for 
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you 
are responsible for evaluating the safety of the final products or systems manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas 
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of 
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these 
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance 
with applicable laws and regulations. 

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is 
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations 
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions. 

12. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or 
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document. 

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics. 
14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas 

Electronics products. 

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled 
subsidiaries. 

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.  
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Corporate Headquarters  Contact information 
TOYOSU FORESIA, 3-2-24 Toyosu, 
Koto-ku, Tokyo 135-0061, Japan 
www.renesas.com 

 For further information on a product, technology, the most up-to-date 
version of a document, or your nearest sales office, please visit: 
www.renesas.com/contact/. 

Trademarks   
Renesas and the Renesas logo are trademarks of Renesas Electronics 
Corporation. All trademarks and registered trademarks are the property 
of their respective owners. 

  

 

https://www.renesas.com/
https://www.renesas.com/contact/

	1. Package Contents
	1.1 Software
	1.2 Document

	2. File Structure
	3. About BiSS Sample Program 
	3.1 Software Information
	3.1.1 Base OS
	3.1.2 Memory Size

	3.2 Hardware Information
	3.2.1 Device
	3.2.2 Target Board

	3.3 Procedures on Development Environments: CR52 ver.
	3.3.1 Preparation before Executing the Sample Program
	3.3.2 EWARM: IAR Systems
	3.3.3 e2 studio: RENESAS

	3.4 Procedures on Development Environments: CA55 ver.
	3.4.1 Preparation before Executing the Sample Program
	3.4.2 EWARM: IAR Systems
	3.4.3 e2 studio: RENESAS



